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Introduction
1 Introduction
1.1 Manufacturer

1.2 Content of this Document
This document guides you through the installation steps necessary to install the software 
components of a device type manager (DTM).

The following software components must be installed:
• Microsoft® .Net Framework 3.5 or higher
• FDT framework program PACTwareTM 5.X
• Device type manager (DTM)

1.3 Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and 
dismounting lies with the plant operator.
Only appropriately trained and qualified personnel may carry out mounting, installation, 
commissioning, operation, maintenance, and dismounting of the product. The personnel must 
have read and understood the instruction manual and the further documentation.
Prior to using the product make yourself familiar with it. Read the document carefully.

Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
Internet: www.pepperl-fuchs.com

Note!
The installation steps are described in the manual using the device type manager 
"DTM Interface Technology" as an example.

Note!
If one of the software components is already installed on your system, you do not need to 
reinstall it.
4
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Symbols Used
This document contains information that you must read to avoid property damage.

Warning Messages

Informative Symbols

Action
This symbol indicates a paragraph with instructions. You are prompted to perform an action or 
a sequence of actions.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result 
in their complete failure.

Note!
This symbol brings important information to your attention.
5
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2 Product Description
FDT Concept
The FDT concept (FDT – Field Device Tool) created a standard that can be used to integrate 
devices in various user interfaces (framework applications such as PACTware. 
The FDT concept enables open and continuous device operation from the control level to the 
field, regardless of the bus systems used. The FDT concept specifies the data exchange 
between the device-specific driver and the framework application. Every communicating 
device has a device-specific driver (DTM) that is integrated in the framework application.

PACTwareTM Operating Software
PACTware (PACTware – Process Automation Configuration Tool) is a manufacturer-
independent operating software for devices. In the past, it was often necessary to use multiple 
manufacturer-specific programs in order to be able to operate different devices. PACTware 
enables you to operate any number of devices with just this software. To operate devices, 
PACTware uses a standardized interface between the framework program and the individual 
software modules. This interface is called FDT. The software modules for device operation are 
called DTMs.

Device and Communication DTM
The DTM (DTM – Device Type Manager) contains all the data and functions of a device. 
Every DTM contains its own user interface optimized for the device. The device and 
communication DTMs can be integrated in any FDT framework program, such as PACTware.
The DTM offers almost no restriction with regard to display and user guidance. This means that 
all available device functions can be operated according to the user's needs. Operation is 
supported by graphics. The DTM technology enables consistent operation of a device in all 
FDT systems.
Essentially, there are two different types of DTM:
• Device DTMs

Device DTMs are DTMs for configuring devices such as transmitter power supplies, signal 
converters, and trip amplifiers.

• Communication DTMs
Communication DTMs are required for communication with a device via a point to point 
connection or via any network structures. The communication DTMs are available for 
various interfaces, such as an RS 232 interface or USB interface. PACTware contains 
a communication DTM.
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3 Prerequisites
The following prerequisites must be fulfilled for the installation and configuration of the DTM:

Hardware Prerequisites
• IBM® PC or compatible PC
• Intel/AMD processor min. 500 MHz
• Working memory: min. 256 MB
• Hard disk space: min. 200 MB
• Graphic resolution 1024 x 768
Software Prerequisites
• Operating system: Microsoft® Windows XP, Windows Vista, Windows 7, Windows 8 or 

Windows 10
• Internet Browser: Microsoft® Internet Explorer 4.0 or higher
• Software components for installation

• Microsoft® .Net Framework 3.5 or higher
• FDT framework program PACTware 5.X
• the application-specific device type manager

Note!
For installation with Windows, administrator rights are required.
7
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Where to find the required software components:
Checking the Microsoft® .Net Framework Version
Normally, it is not necessary to install the Microsoft® .Net Framework software, because the 
software is integrated in the operating system. Check which 
Microsoft® .Net Framework version is installed on your PC.
1. Open the system control on your PC.
2. Open the overview of installed programs by double-clicking Software.

 The overview of installed programs is displayed.

Note!
The Microsoft ® .NET framework software is available for download from 
www.microsoft.com/download.
8

www.microsoft.com/download
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Downloading the FDT framework program PACTware 5.X from the Internet
1. In the Internet browser, enter www.pepperl-fuchs.de.
2. In the search field, enter the product name of the software component: PACTware.

 The results list is displayed.
3. In the results list, find the PACTware 5.x entry and click the Software button.

 The zip file containing the PACTware 5.x software is saved.
4. Unzip the zip file.
5. Save the data to a temporary folder of your choice on your PC.
Downloading the Device Type Manager from the Internet

1. In the Internet browser, enter www.pepperl-fuchs.de.
2. In the search field, enter the product name of the software component: DTM.

 The results list is displayed.
3. In the Products section, click the DTM Interface Technology link.

 The Internet browser displays the product page.
4. In the Software section, click the DTM Collection Interface Technology 2 link.
5. Load the software to your PC.
6. Unzip the ZIP file.
7. Save the data to a temporary folder of your choice on your PC.

Note!
The steps are described using the device type manager "DTM Interface Technology" as an 
example.
9
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4 Installation
4.1 FDT Framework Program PACTware

To work, the DTM always requires an FDT framework program such as PACTware. 
The installation sequence of the DTM and the respective FDT framework program is not 
defined. We recommend the following installation sequence:
1. Installation of the FDT framework program PACTware
2. Installation of the DTM

Installing the FDT Framework Program PACTware
1. Load the FDT framework program PACTware to your PC. See chapter 3.
2. Unzip the ZIP file.
3. Save the data to a temporary folder of your choice on your PC.
4. Start the installation by double-clicking the setup.exe file.

 The Select Language window is displayed.

5. In the drop-down list, select the installation language and confirm your selection with OK.
 The list of available software is displayed.

Note!
You do not have to uninstall older PACTware versions. Additional information on 
the PACTware versions can be found at the end of the manual. See chapter 6.

Note!
If you select the reverse order, you must update the DTM device catalog before you edit a 
project. See chapter 5.1.
10
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6. Select PACTware 5.X and confirm your selection with Install.
 The installation wizard is displayed.

7. Follow the installation instructions and confirm the installation steps.
 The window with the license terms is displayed.
11
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8. Agree to the End User License Agreement and confirm your entry with Next.
9. Follow the installation instructions and confirm the installation steps.

 The installation completion window is displayed.

10. Confirm the end of the installation with Finish.
 The FDT framework program PACTware software is installed.
12
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4.2 Device Type Manager
To work, the DTM always requires an FDT framework program such as PACTware. 
The installation sequence of the DTM and the respective FDT framework program is not 
defined. We recommend the following installation sequence:
1. Installation of the FDT framework program PACTware
2. Installation of the DTM

Installing the Device Type Manager

1. Load the DTM Interface Technology to your PC. See chapter 3.
2. Unzip the ZIP file.
3. Save the data to a temporary folder of your choice on your PC.
4. Start the installation by double-clicking the setup.exe file.

 The list of available software is displayed.

Note!
If you select the reverse order, you must update the DTM device catalog before you edit a 
project. See chapter 5.1.

Note!
The steps are described using the device type manager "DTM Interface Technology" as an 
example.
13
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4.2.1 Device DTMs
Installing Device DTMs
1. Select DTM Coll. Conventional Interface and confirm your selection with 

Install selected application(s).

 The Language Selection window is displayed.
14



Installation and Configuration Device Type Manager (DTM)
Installation
20
18

-0
3

2. In the drop-down list, select the installation language and confirm your selection with OK.
 The Install window is displayed.

3. Click Yes to confirm the installation start.
 The installation wizard is displayed.
15



 20
18

-03

Installation and Configuration Device Type Manager (DTM)
Installation
4. Follow the installation instructions and confirm the installation steps.
 The window with the license terms is displayed.

5. Agree to the End User License Agreement and confirm your entry with Next.
 The Customer Information window is displayed.
16
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6. Enter the required texts in the User Name and Organization fields.
7. Confirm your entry with Next.

 The window for selecting the type of setup is displayed.
17
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8. Select the required setup type.
The Complete option installs all DTMs available in the package.
The Custom option allows individual DTMs to be selected.

9. Confirm your selection with Next.
18
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10. Follow the installation instructions and confirm the installation steps.
 The installation completion window is displayed.

11. Confirm the end of the installation with Finish.
 The device DTMs are installed.
19
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4.2.2 Communication DTMs
Two communication DTMs are available, depending on the Windows operating system:
• Microsoft® Windows XP, Windows Vista, and Windows 7/32 Bit operating systems:

USB Driver for K-ADP-USB
• Microsoft® Windows 7/64 Bit operating system:

USB Driver for K-ADP-USB (W7/64)
Installing Communication DTMs
1. Select the appropriate communication DTM for your operating system.
2. Select USB Driver for K-ADP-USB and confirm your selection with 

Install selected application(s).

or
Select USB Driver for K-ADP-USB (W7/64) and confirm your selection with 
Install selected application(s).
20
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 The installation wizard is displayed.

3. Follow the installation instructions and confirm the installation steps.
 The window with the license terms is displayed.
21
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4. Agree to the End User License Agreement and confirm your entry with Next.
5. Follow the installation instructions and confirm the installation steps.

 The installation completion window is displayed.

6. Confirm the end of the installation with Finish.
 The communication DTM is installed.
22
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4.3 Connection between Device and PC
Before you connect the device to the PC, please note the following:

Connecting the Device to the PC via the 9-Pin Serial Interface
1. Mount the device as described in the system description.
2. Connect the device to the power supply as described in the system description.
3. Connect the device to the PC via the adapter with serial interface K-ADP1.

- Connection on the device: front programming socket
- Connection on the PC: 9-pin serial interface

Note!
In the past, the device programming sockets and the K-ADP1 adapter plugs were 
3.55 mm x 18.3 mm. There was no additional adapter cable for the adapter.
• Use this adapter for devices with programming sockets that are 3.55 mm x 18.3 mm.
• If you use this adapter with devices with programming sockets that are 3.5 mm x 14 mm, 

the plug protrudes by approximately 3 mm. The function is not impaired.
The newer devices and the K-ADP1 and K-ADP-USB adapters have programming sockets 
and plugs that are 3.5 mm x 14 mm. The adapters have an additional adapter cable with plug 
dimensions 3.55 mm x 18.3 mm.
• Use these adapters for devices with programming sockets that are 3.5 mm x 14 mm.
• If you are using these adapters with devices with programming sockets that are 

3.55 mm x 18.3 mm, insert the additional adapter cable.
23
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Connecting the Device to the PC via the USB Interface
1. Mount the device as described in the system description.
2. Connect the device to the power supply as described in the system description.
3. Connect the device to the PC via the adapter with USB interface K-ADP-USB.

- Connection on the device: front programming socket
- Connection on the PC: USB interface

 The hardware wizard is displayed. Read the note.

4. Follow the installation instructions and confirm the installation steps.
 The installation completion window is displayed.

5. Confirm the end of the installation with Finish.
 The interface driver is installed.

Note!
The hardware wizard is displayed only on initial installation or for an update.
24
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5 Configuration

5.1 Updating the Device Catalog
Starting the Program
Start PACTware by double-clicking the icon .

 The PACTware main window is displayed.

Note!
The steps are described using the device type manager "DTM Interface Technology" as an 
example.

1 2

1 Project range
2 Operating range
25
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Changing the Language
1. Change the language using the menu Extras > Options.

 The Options window is displayed.

2. Open the Language drop-down list.
3. Select the required language in the drop-down list.

4. Confirm your selection with OK.
26
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Updating the device catalog
1. Close all open projects using the menu File > Close.

2. Open the device catalog using the menu View > Device catalog.
27
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 The device catalog is displayed.

3. Update the device catalog using the Update device catalog button.

 The query window is displayed.

4. Click Yes to confirm the prompt.
 The updated device catalog is displayed.
28
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5.2 Starting and Saving a Project
Starting a Project

1. Start PACTware by double-clicking the icon .
 The PACTware main window is displayed.

2. Start a new project via Create new project.

Saving a Project
1. Save the project using the menu File > Save as.

Note!
For more information on operating PACTware, see the online help.
29
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2. Enter a project name and confirm the entry with Save.

 The project name is displayed.

Note!
For more information on operating PACTware, see the online help.
30
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5.3 Configuring the Communication DTM
The device is connected to the PC via the 9-pin serial interface or the USB interface.

Starting a Project

1. Start PACTware by double-clicking the icon .
 The PACTware main window is displayed.

2. Start a new project via Create new project.

or
Opening a Project

1. Start PACTware by double-clicking the icon .
 The PACTware main window is displayed.

2. Open an existing project with Open project.

Note!
The communication DTM P2P RS232 FDT is required for both connection versions via the 
9-pin serial interface and the USB interface. You cannot configure the device DTMs until 
you have configured the communication DTM.
31
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Adding a Communication DTM to the Project
1. In the project window, select HOST PC and then use the right mouse button to open the 

context menu.
2. Select Add device.

 The list of communication DTMs is displayed.
32
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3. Select the communication DTM P2P RS232 FDT and confirm your selection with OK. 
The communication DTM P2P RS232 FDT is required for both connection 
versions — via the 9-pin serial interface and the USB interface.

 The communication DTM is included in the project tree.

Configuring the Communication DTM
1. Where necessary, disconnect the PC from the communication DTM. See the 

"Disconnecting the Communication DTM and PC" section in this chapter.
2. In the project window, select P2P RS232 FDT and then use the right mouse button to open 

the context menu.
3. Choose Parameter.
33
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 The Parameter window is displayed.

4. From the Communication Port drop-down list, select the desired parameter. You can 
select communication port USB 1 (K-ADP-USB) only if the K-ADP-USB adapter was 
connected before you started to configure the communication DTM. See chapter 4.3.

5. From the Communication Retries drop-down list, select the desired parameter.

 The communication DTM is configured.
34
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Establishing the Connection between the Communication DTM and PC
1. In the project window, select P2P RS232 FDT and then use the right mouse button to open 

the context menu.
2. Choose Connect.

 The connection is established. The connection status is displayed: 
Disconnecting the Communication DTM from the PC
1. In the project window, select P2P RS232 FDT and then use the right mouse button to open 

the context menu.
2. Choose Disconnect.

 The connection is disconnected. The status is displayed: 
35
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Saving a Project
Save the project with Save project.

Note!
For more information on operating PACTware, see the online help.
36
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5.4 Configuring the Device DTM
Various device DTMs are available for the devices. Select the appropriate device DTM for your 
device from the device list. You can configure the device only if you have selected the correct 
device DTM.

Device Device DTM Group
ED2-UT-Ex2
ED2-UT-Ex2-2

ED2-UT-* FDT Temperature

HiC2081 HiC2081 FDT Temperature
HiD2081 HiD2081 FDT Temperature
HiD2082 HiD2082 FDT Temperature
HiD2891 HiD2891 FDT Digital input
KFD2-CRG-1.D
KFD2-CRG-Ex1.D
KFU8-CRG-1.D
KFU8-CRG-Ex1
KFU8-CRG-Ex1.D

KF*-CRG-* FDT Analog input

KFD2-CRG2-1.D
KFD2-CRG2-Ex1.D
KFU8-CRG2-1.D
KFU8-CRG2-Ex1.D

KF*-CRG2-* FDT Analog input

KFD2-GU-1
KFD2-GU-Ex1

KFD2-GU-* FDT Temperature

KFD2-GUT-1.D
KFD2-GUT-Ex1.D
KFU8-GUT-1.D
KFU8-GUT-Ex1.D

KF*-GUT-* FDT Temperature

KFD2-UFC-1
KFD2-UFC-1.D
KFD2-UFC-Ex1
KFD2-UFC-Ex1.D
KFU8-UFC-1
KFU8-UFC-1.D
KFU8-UFC-Ex1
KFU8-UFC-Ex1.D

KF*-UFC-* FDT Digital input

KFD2-UFT-2.D
KFD2-UFT-Ex2
KFD2-UFT-Ex2.D
KFU8-UFT-2.D
KFU8-UFT-Ex2
KFU8-UFT-Ex2.D

KF*-UFT-* FDT Digital input

KFD2-UT-1
KFD2-UT-1-1
KFD2-UT-Ex1
KFD2-UT-Ex1-1

KFD2-UT-* FDT Temperature
37
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Starting a Project

1. Start PACTware by double-clicking the icon .
 The PACTware main window is displayed.

2. Start a new project via Create new project.

or
Opening a Project

1. Start PACTware by double-clicking the icon .
 The PACTware main window is displayed.

2. Open an existing project with Open project.

KFD2-UT2-1
KFD2-UT2-1-1
KFD2-UT2-2
KFD2-UT2-2-1
KFD2-UT2-Ex1
KFD2-UT2-Ex1-1
KFD2-UT2-Ex2
KFD2-UT2-Ex2-1

KF*-UT2-* FDT Temperature

KFD2-WAC2-1.D
KFD2-WAC2-Ex1.D

KF*-WAC2-* FDT Analog input

Table 5.1

Device Device DTM Group

Note!
The configuration of the device is shown using the configuration of the KFD2-UT2-Ex2 
temperature converter as an example.
38
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Adding a Device to the Project
1. Add a communication DTM to your project. See chapter 5.3.
2. In the project window, select P2P RSD232 FDT and then use the right mouse button to 

open the context menu.
3. Select Add device.
39
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 The list of device DTMs is displayed.

4. Select the required device DTM and confirm your selection with OK. Example: KF*-UT2-
*FDT.

 The device DTM is included in the project tree.
40
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Establishing the Connection between the Device and PC
1. In the project window, select KF*-UT2-*FDT and then use the right mouse button to open 

the context menu.
2. Choose Connect.

 The connection is established. The connection status is displayed: 
Configuring the Device
1. In the project window, select KF*-UT2-*FDT and then use the right mouse button to open 

the context menu.
2. Choose Parameter.
41
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 The Parameter window is displayed.
42
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Changing the Language for Parameter Window
1. Change the language using the menu Language in the Parameter window.
2. Select the required parameter language in the drop-down list.

 The Language for Parameter window is changed.
Loading Device Data from the Device
1. In the project window, select KF*-UT2-*FDT and then use the right mouse button to open 

the context menu.
2. To transfer device data from the device to the PC, choose Load from device.
43
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 The device data is displayed.
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Editing Device Data
1. In the project tree, choose the entry that you want to edit. Example: Input 1.

 The device data for Input 1 is displayed.

2. Edit the device data. For more information about editing the device data, see the 
KFD2-UT2-(Ex)*(-1) Temperature Converter Manual.

3. Select the required parameter from the drop-down list.
4. Confirm your selection with Return.
45
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Storing Device Data on the Device
1. In the project window, select KF*-UT2-*FDT and then use the right mouse button to open 

the context menu.
2. To transfer device data from the PC to the device, choose Store to device.

 The device is now configured.
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Disconnecting Devices from PCs
1. In the project window, select KF*-UT2-*FDT and then use the right mouse button to open 

the context menu.
2. Choose Disconnect.

 The connection is disconnected. The status is displayed: 
3. Disconnect the device from the PC by removing the adapter cable from the device or PC.
Saving a Project
Save the project with Save project.

Note!
For more information on operating PACTware, see the online help.
47
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6 Additional Information on PACTware

The following information is available:
• PACTware support contacts
• Release information
• Compatibility of PACTware with other software components
• Compatibility of PACTware functions
• Supported languages

Note!
You can find additional information about PACTware on the website 
http://www.pactware.com/support.

http://www.pactware.com/support
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